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Overview

ooh!Media is an application used to create messages for your sign. In ooh!Media you can create basic 
text messages, messages with animations or graphics, and messages with both text and graphics or 
animations.
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This Quick Start is intended to help you quickly learn how to create and customize messages. We use a 
48x96 size sign for the examples, but you can use your sign to follow the instructions.

This Quick Start was designed to be used with a full color RGB sign. If your sign doesn’t support full color, 
use colors that are appropriate for your sign such as red or amber. 

Quick Start
Get started sending messages to your sign fast!



PN 1181610201A   2

ooh!Media Quick Start

   Setting up your workspace
You can customize ooh!Media to your personal 
taste by setting which items you want to appear 
in the ooh!Media window. For the purpose of this 
Quick Start we will use the Expert Layout because 
it makes everything we need available on the 
screen and is fairly easy to use.

To set ooh!Media to Expert Layout:
Open ooh!Media. 
Select the Start button, All Programs, 
ooh!Media, and then choose ooh!Media.
From the View pull-down menu, select 
Expert Layout. 

Your ooh!Media window should look similar 
to the following:

1.

2.

    Creating text messages

For our fi rst message we will create a message 
for the new year. Our goal is to create a message 
with the text, “Happy New Year” that scrolls across 
the sign.

   To create a basic text message:
When you fi rst open ooh!Media, it starts a new 
empty message for you. 

Click in the Emulation Area to create a new 
text box.

Select all of the text inside the text box.
Tip: To select all the text in the message, 

click inside the text box and 
simultaneously press the CTRL+A keys.

1.

2.



PN 1181610201A   3

ooh!Media Quick Start

On the Text tab under Font, select Arial Black 
and then type the following text:
Happy New Year!

Select all the text in the text box and then 
click the color swatch on the Text tab.

Color Swatch

The color dialog opens.

Click the yellow swatch and click OK.

3.

4.

5.

Move the text box to the upper left corner.
Hover your cursor over the text box border in 
the Emulation Area until four arrows appear 
and then click and drag it to where you want.

Size the text box so it takes up the whole 
Emulation Area.
Hover your cursor over one of the text box 
borders until it changes to two arrows and 
then click and drag to stretch the box. 

Save the message.
Click the disk button or select Save from 
the File pull-down menu and name the 
fi le  Happy New Year.

Preview the message. 
Click the preview button in the toolbar 
at the top of the window.

6.

7.

8.

9.
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Our message looks like this:

To select a message:
When messages are not visible in the Emulation 
Area, you can select them in the TimeLine.
If you don’t see the text box in the Emulation Area,
select the text box in the TimeLine to make it reappear.

  To extend the message length :
In the TimeLine, hover your cursor along the 
right edge of the message until two arrows 
appear.
Click and drag the box to 20 seconds.

Stretch the text message

Save your message and preview it again.

1.

2.

3.

    Adding time and temperature to messages

  To add time to the message:
Make sure nothing is selected in the 
Emulation Area. 

Click in the white space to
make sure nothing is selected.

Click the clock button.
The Time Format dialog opens.

Clock button

In Time Format dialog, select the option 
showing hours and minutes and click OK.

A time box is added to the TimeLine and the 
Emulation Area:

1.

2.

3.
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In the TimeLine, extend the length of the time 
message so it is the same length as the Happy 
New Year message. 
Move the time message box to the lower left 
corner and make it smaller. 

Select all the text in the time message box.
On the Text tab under Font, select Arial Black 
and select 1/4 from the Size list.

Note: The options in the Size list represent 
proportions of the sign height. For 
example, 1 is the full height of the sign 
and 1/2 is half the sign height.

Click the Color swatch, select Yellow in the 
Color dialog and click OK.
On the Text tab under Alignment, select the 
align-bottom button.

Align bottom button

4.

5.

6.
7.

8.

9.

Size the time message as necessary.
Tip: When adjusting the size of the 

temperature and time messages, make 
sure you leave enough room for all 
characters to appear. For example, if 
it’s 1:00 PM now, make sure you leave 
enough room for 12:59 PM.

Save and preview your message.

Our message looks like this:

  To change the scroll effect:
Select the time message box.
Click the Eff ect tab near the bottom of the 
ooh!Media window and under Hold Eff ect, 
select Standard as the Eff ect. This keeps the 
message on the sign.

Save and preview your message.

10.

11.

1.
2.

3.
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  To add the temperature to the message:
Note: To have this message work on your sign, 

you must have the optional temperature 
probe installed. However, you can create 
a message in ooh!Media without the 
temperature probe installed on your sign.

Make sure nothing is selected in the 
Emulation Area. 
On the Text tab, click the thermometer 
button.

Thermometer button

The Temperature Format dialog opens, check 
the Use Degree Symbol box and click OK.

A temperature message box is added:

Extend the length of the temperature 
message in the TimeLine so it is the same 
length as the time message.

1.

2.

3.

4.

If you don’t see the temperature message in 
the TimeLine, use the scroll bar on the right 
edge of the TimeLine to scroll down until it is 
visible.

Scroll bar

Resize and move the temperature box to the 
lower right corner. 

Select all the text in the temperature box and 
do the following on the Text tab:

Under Font, select Arial Black, select  
1/4 for the Size, and change the color to 
yellow.
Click the right-align button.
Click the align-bottom button.

With the Temperature box selected, click 
the Eff ect tab and set the Hold Eff ect to 
Standard.

Save and preview your message.

5.

6.

7.

8.
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Our message looks like this:

  Creating messages with reverse text

For this example, we will create a new message 
for the reverse text and make it take the whole 
sign. We will create a yellow background, set the 
text color to red, and add a drop shadow.

  To create a solid background:
Click Create to start a new message fi le.

Create command

Click the Insert button on the button bar and 
select Background Color.

Insert background button

1.

2.

A Background Color box is added to the 
Background row in the TimeLine.

Click the Background tab at the bottom of 
the screen.

Background tab

On the Background tab under Type, click the 
Color swatch.
In the Color dialog, select yellow and click OK.
In the TimeLine, stretch the Color box to 20 
seconds.

Save your message as Reverse Text.

3.

4.

5.
6.

7.
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  To add the text:
In the same message, insert a text box by 
selecting Text from the Insert pulldown 
menu.
Select all the text and type the following:
Sale Today Only!
Size the text box so it takes up the whole 
Emulation Area. 

If the text message is attached to the 
Background, right-click the text box in the 
TimeLine and select Assign To Time. 

Click the Text tab and make any other 
adjustments you want such as aligning the 
text vertically, using a diff erent font, etc. We 
changed the font in our message to Arial 
Black.
Under Font, select 1 for the Size so the text 
takes up the whole sign.

1.

2.

3.

4.

5.

6.

Click the Color swatch, select Red in the Color 
dialog, and then click OK.

Save and preview the message.

Our message looks like this:

To add a drop shadow:
Select all the text in the message.
On the Text tab under Shadow, enter 3 in the 
Depth box.

Shadow settings

Set the direction to 300.
Select black for the drop shadow color and 
click OK.
Save and preview your message.

7.

8.

1.
2.

3.
4.

5.
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Our message looks like this:

Note: Even though the message only loops once 
during preview, it will loop continuously on 
the sign.

   Creating messages with animations

In this example we will use an animation fi le from 
the Media Library to create a message for the 
Fourth of July.

To create a message with an animation:
In ooh!Media, create a new message.
Click the Media Library tab at the bottom of 
the ooh!Media window and select Sample 

Images from the Image Category list.

Media Library tab

Image Category list

1.
2.

Click and drag the july4th96x48RGB.gif fi le 
to the Emulation Area.

Click and drag the file
to the Emulation Area.

This adds the animation to the Emulation 
Area.

If the following prompt appears, click Yes and 
ooh!Media will fi ll the Emulation Area with 
the animation.

In the TimeLine, stretch the message length 
to 20 seconds.
Save the message as July 4th 
Animation.
Preview the message. 

3.

4.

5.

6.

7.
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  Creating messages with text and graphics

Now we want to use a graphic as a background 
and add some of our own text. 

There can only be one background in a message, 
but you can use multiple text boxes.

To create a message a graphics:
In ooh!Media, create a new message.
Click the Media Library tab at the bottom of 
the ooh!Media window and select Sample 

Images from the Image Category list.

Media Library tab

Image Category list

Click and drag the coff ee96x48.bmp fi le to 
the Emulation Area.

Click and drag the file
to the Emulation Area.

1.
2.

3.

This adds the image to the Emulation Area.

If the following prompt appears, click Yes and 
ooh!Media will fi ll the Emulation Area with 
the animation.

In the TimeLine, stretch the message length 
to 20 seconds.
Size the coff ee cup image so it takes up the 
left half of the Emulation Area.
For our sign, we sized the image a little bit 
smaller. Size and position your message as 
appropriate for your sign.

Save the message as Joe’s Coffee.

4.

5.

6.

7.
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To add the fi rst text box:
Click in the other half of the Emulation Area 
to add a text box.

Select all the text and type the following:
Joe’s
Coffee

In the TimeLine, stretch the new text message 
to 20 seconds.
On the Text tab, set the following:

Font to Tahoma

Size to 1/4

Color to Yellow

Align to the bottom
Align center

1.

2.

3.

4.

Position and resize the text box as needed.
On the Eff ects tab, set the Hold Eff ect to 
Standard.
If you preview the message now, you will 
notice that the text is not visible. Assigning it 
to the TimeLine makes it visisble.
To assign the new message to the TimeLine, 
right-click it in the TimeLine and select 
Assign  to TimeLine.

After you assign the text message to the 
TimeLine, you may need to reposition it in the 
Emulation Area.
Save you rmessage.

6.
7.

8.

9.
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To add the second text box:
From the Insert pulldown menu, select Text. 

This assigns the text box to the TimeLine.

Select all the text in the new text box and 
type:
Get Your Coffee at the Drive 
Thru!
On the Text tab, set the following:

Font to Tahoma

Size to 1/3

Color to Yellow

Align-middle
On the Eff ects tab, set the Hold Eff ect to 
Scroll.
In the TimeLine, stretch the message to 20 
seconds.
Position the message in the upper right 
portion of the Emulation Area.

1.

2.

3.

4.

5.

6.

Save and preview your message.

Our message looks like this:

Notice the bottom text message stays on the sign 
while the top one scrolls.

7.


